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Question 

How do you implement chronological messaging with S7-400 CPUs and WinCC? 

Answer 

Follow the action commands and notes listed in this document for a detailed 
answer to the above question. 

http://support.automation.siemens.com/WW/view/de/23730697
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1 Information 

1.1 Instructions 

This entry shows you how to implement chronological messaging with an S7-400 
CPU and WinCC. Chronological messaging means that the messages are sent 
from the PLC to the WinCC station. When they are created in the PLC, the 
messages are given a time stamp and then sent to the WinCC station. The WinCC 
station does not poll the PLC, which significantly reduces the bus load. There are 
basically two types of message in STEP 7: 

1. Symbol-related messages  
Symbol-related messages can only be generated by CPUs of the S7-400 
series. The messages are triggered asynchronously to the program. 

2. Block-related messages 
Block-related messages can be generated by CPUs of the S7-300 and S7-400 
series. 
The block-related messages are created by the STEP 7 program using the 
system message blocks (e.g. ALARM_8P). The message is sent as soon as 
the STEP 7 program calls a system message block and the conditions for 
sending a message are fulfilled. The messages are triggered synchronously to 
the program. 

1.2 Message classes 

Messages are sorted into message classes according to their usage (e.g. Alarm, 
Warning). You can configure 16 message classes. 

1.3 Message types 

The message types divide the message classes once again (e.g. Alarm High for 
High Limit Exceeded, Alarm Low for Low Limit Exceeded). You can configure 16 
message types per message class. 

Note The message types are numbered consecutively, i.e.: 

 Message class 1 has message types 1-16 

 Message class 2 has message types 17-32 

 Message class 16 has message types 241-256 

The texts of message classes and message types are not compiled to WinCC, 
only the message class and message type numbers are used to assign the 
messages in WinCC to a message class and message type respectively. 

 

 

WARNING The message class and message type numbers used in STEP 7 must also 
be configured in WinCC. If a message is triggered in STEP7 with a 
message class number or message type number, for which no message 
class or message type number is configured in WinCC, then this is marked 
purple in Alarm Logging and no message is displayed in the Runtime. 
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1.4 OS project editor 

If you are using the OS project editor, the message classes and message types 
that are available to you for configuring messages are created automatically. It is 
not necessary to configure the messages in WinCC. 

If you do not use the OS project editor, you must configure the message classes 
and message types in WinCC. For which STEP 7 message class is assigned to 
which message class and message type in WinCC, please refer to Entry ID: 
31622970. 

1.5 Block attribute alarm_ui 

If this block attribute is set to "True", the PCS 7 message configuration dialog is 
available. In this dialog, the following texts are added automatically to the 
messages and do not have to be configured. 

 Origin 

 Area 

 Charge Name 

 Operation 

If this block attribute is set to "False", the message text and 9 additional texts are 
available for each message when configuring messages. These texts are assigned 
to the corresponding user text blocks in WinCC. Instructions for configuring the 
additional texts and the assignment of the additional texts are available in Entry ID: 
30550239. 

http://support.automation.siemens.com/WW/view/en/31622970
http://support.automation.siemens.com/WW/view/de/30550239
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1.6 Additional information 

 Reference manual "Programmable Logic Controller S7-400 CPU Data" 
This gives you detailed information on the available message procedures of a 
CPU. This documentation is part of the documentation package 6ES7498-
8AA03-8AA0. The manual is available for downloading in Entry ID: 19538001. 

 Manual "Operation List S7-400 CPU 412, 414, 416, 417" 
This gives you detailed information on available system functions and system 
function blocks for creating CPU messages. This documentation is part of the 
documentation package 6ES7498-8AA04-8AN0. The manual is available for 
downloading in Entry ID: 1117645. 

 STEP 7 Online Help 
You can find detailed information about alarm processes, alarm types and 
system alarm blocks in the STEP 7 Online Help. 

http://support.automation.siemens.com/WW/view/de/19538001
http://support.automation.siemens.com/WW/view/de/1117645
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2 Configuration 

Requirements 

 The WinCC component "AS-OS Engineering" is installed. 
You can select this component when doing a user-defined setup of WinCC. 
Please use the following installation sequence:  

3. STEP 7  

4. WinCC with the "AS-OS Engineering" component 
Entry ID: 22272911 includes a description of how to retro-install the "AS-OS 
Engineering" component. 

 The WinCC project is integrated in the STEP 7 project. 
Entry ID: 11841504 contains information on how to integrate a WinCC project 
in STEP 7. 

 The "Alarm Logging Runtime" is enabled in the startup list in the "Computer 
Properties" dialog of the WinCC project. 

Below we show you how to configure symbol-related and block-related messages. 
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2.1 Configuring symbol-related messages 

2.1.1 Configure extended attributes for messaging in the symbol table 

1. In SIMATIC Manager, open the symbol table.  

2. Using the menu command "View > Columns R, O, M, C, CC Ctrl+K" you make 
additional properties to the symbols used visible.  

3. Create a symbol (e.g. "PUMP1_Message0") that is to trigger a message. 
Assign an address, e.g. "M100.0" (BOOL data type). 

Figure 2-1 

 

http://support.automation.siemens.com/WW/view/de/22272911
http://support.automation.siemens.com/WW/view/de/11841504
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4. Assign the attribute "M" for messaging for the symbol that is to trigger a 
message. For this you open the "Message Configuration" dialog by clicking on 
the relevant option field in the "M" column. You can also open the "Message 
Configuration" dialog via the pop-up menu "Special Object Properties > 
Message...". 
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Figure 2-2 

 
 

5. Make the settings in the "Message Configuration" dialog. 

Figure 2-3 
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6. Here you can parameterize the message and information texts, the message 
class and other properties of the message. With the "More>>" button you can 
parameterize more parameters (e.g. Additional text, SCAN attributes etc.). 
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Figure 2-4 

 
 

7. Click the "OK" button to acknowledge the message configuration.  

8. Repeat the message configuration for all the symbols that are to generate 
messages.  

9. Save the symbol table, for example, using the menu command "Symbol Table 
> Save". When you save the symbol table, a system data block ("SDB 305") is 
created. 

Note It is also possible to configure the message texts in multiple languages. The 
display language currently selected is shown in the "Message Configuration" 
dialog. You configure the message texts for all those languages that will be used 
later for WinCC Runtime. For this you change the standard language in the 
SIMATIC Manager with the menu command "Options > Language for Display 
Devices" and repeat message configuration for each language separately.  

The attribute in the "O" column (operator control and monitoring) determines 
whether the symbol is created as a WinCC tag when compiling is performed. 

 

 

2.1.2 Download program in PLC 

Download the S7 program into the PLC. 

2.1.3 Compile the OS 

"OS Compile" creates the messages in WinCC. In earlier versions the procedure 
was also done with "Mapping" or "Transfer PLC/OS Connection Data".  
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Requirements 

The PLC's CPU and the OS must be networked. There must be at least one 
common network connection in NetPro. 

Figure 2-5 
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1. Start the OS compilation procedure. In the SIMATIC Manager you select the 
OS and then in the associated pop-up menu you select "Compile". 

Figure 2-6 
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A wizard takes you through multiple dialogs. Here you can make various settings 
for compiling the OS. You must select which PLC program is assigned to which OS 
and which connection is to be used. 

Note Using the "Back" and "Next" buttons you can navigate in the wizard's settings 
mask. With the "Finish" button you get a summary of the compilation procedure 
displayed. 

 

 

2. Start the compilation procedure with the "Compile" button. 

2.1.4 Download the OS 

Download the program into the OS. 



 
Configuring chronological messaging

  Entry ID: 23730697
 

 
V1.1 12.12.2008 11/19
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 2
0

0
8 

A
ll 

rig
h

ts
 r

e
se

rv
e

d
 

2
3

73
0

69
7

_
W

in
C

C
_

Z
e

itf
o

lg
e

R
ic

ht
ig

M
e

ld
en

S
74

0
0_

e
.d

o
c 

2.1.5 Test the messages at WinCC Runtime 

Start WinCC flexible Runtime. Trigger the messages using the variable table. The 
messages are displayed in the alarm window of WinCC and can be acknowledged 
where necessary. 

Figure 2-7 

 
 

2.2 Configuring block-related messages 

Here we present block-related messaging using the system message block SFB35 
(ALARM_8P). The procedure using the other system message blocks is essentially 
identical. 

  

2.2.1 Copy SFC35 (ALARM_8P) into current project 

1. In the SIMATIC Manager you select "File > Open... > Libraries" and open the 
Standard Library.  

2. Select the system message block SFB35 (ALARM_8P). It is located in the 
directory "Standard Library > System Function Blocks > Blocks".  

3. Copy the system message block SFB35 into the project. 
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2.2.2 Create a message-compatible block 

1. Insert a new function block, e.g. "FB1" into the STEP 7 project. The language 
used is STL.  

2. Open the function block "FB1". 

3. Create the following input variables: 

Table 2-1 

Name Datentype 

EV_ID DWORD 

SIG1 ... SIG8 BOOL 

SD1 ... SD10 REAL 

 

4. Create the following output variables: 

Table 2-2 
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Name Datentyp 

DONE BOOL 

ERROR BOOL 

STATUS WORD 

ACK_STATE WORD 

 

5. Create the following instance FB variable in the static area: 

– ALARM (ALARM_8P or SFB35)         

6. Open the "Object Properties" dialog of input "EV_ID". Assign the following 
attributes: 

– S7_a_type = alarm_8p 

– S7_server = alarm_archiv 

Figure 2-8 

 
7. Select the system message block SFB35 (ALARM_8P) in the program part. 
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2.2.3 Connect the parameters of the system message block with the 
corresponding inputs/outputs of the function block 

Figure 2-9 
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Note The "ID" parameter is permanently set with the value "W#16#EEEE". 

The parameters SIG1 to SIG8  trigger the messages. 

The EV_ID parameter receives the message number generated by the system. 

You can configure message-associated values with the parameters SD1 to SD8. 

The parameters DONE, ERROR, STATUS and ACK_STATE provide information 
on operating, error and alarm statuses. 

Repeat this procedure to create up to 7 more messages as required. 

 

 

8. Save the function block FB1 and close the editor. 

2.2.4 Configure standard messages 

1. Select function block "FB1" in the SIMATIC Manager. 
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2. In the pop-up menu you call the command "Special Object Properties > 
Messages...". The Message Configuration dialog opens. 

Figure 2-10 

 
 

3. Specify the message texts for the messages. In this menu you can 
parameterize more message properties (message class, info and additional 
texts, acknowledge group, acknowledge behavior, ...). 

Note It is also possible to configure the message texts in multiple languages. The 
display language currently selected is shown in the "Message Configuration" 
dialog. You must configure the message texts for all those languages that will be 
used later for WinCC Runtime. For this you change the standard language in the 
SIMATIC Manager with the menu command "Options > Language for Display 
Devices" and repeat message configuration for each language separately. 
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2.2.5 Call message-compatible block in the program 

4. Call function block FB1 in your program. 

5. For this you open the organization block OB1 and enter the following code: 
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Figure 2-11 

 
 

WARNING The IDs for the messages are generated automatically by STEP 7. You 
must not change these IDs! 

 

 

6. Save the organization block OB1 and close the editor. 
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2.2.6 Configure block-related messages 

After incorporating the message-compatible block you can change the message 
texts, for example, to display the measuring point name in the message. There are 
various options for displaying the measuring point name in the message: 

Using the symbolic name of the instance data block 

1. Assign a practical name after the instance data block, e.g. the name of the 
measuring point. 

2. Assign a practical name for the S7 program, e.g. the name of the system or 
subsystem. The "Additional text 1" is not used for message configuration. 

After "Compile OS" the User text block1 of the message receives the name of the 
subsystem followed by the name of the measuring point. 

If you have used the OS project editor to install the WinCC project, the User text 
block1 is displayed as "Origin" in the message window. 

Figure 2-12 
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Using additional texts 

3. For each instance data block you call the Message Configuration dialog via 
"Special Object Properties > Messages...". 

4. For "Additional text1" you enter the required text for each message, e.g. 
subsystem and measuring point, for all the relevant languages. 

After compiling the OS the User text block1 of the message then contains the 
Additional text1. This is displayed in the "Origin" column when you use the OS 
project editor. 
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Figure 2-13 
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Extending the message text 

You can also extend the actual message text by adding the subsystem and 
measuring point names.  

1. For each instance data block you call the Message Configuration dialog via 
"Special Object Properties > Messages...". The Message Configuration dialog 
opens. 

2. Change the message text accordingly for each relevant language. 
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Figure 2-14 
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2.2.7 Download PLC, Compile OS and Download OS 

Perform the steps (Download PLC, Compile OS and Download OS) from the 
instructions for symbol-related messaging. 

2.2.8 Test the messages at WinCC Runtime 

Start WinCC flexible Runtime. Trigger the messages using the variable table. The 
messages are displayed in the alarm window of WinCC and can be acknowledged 
where necessary. 

Figure 2-15 

 
This entry has been created with WinCC V6.0 SP4 and STEP 7 V5.3 SP2. The 
entry was also tested with WinCC V7.0 and STEP 7 V5.4 SP4. 
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3 History 
Table 3-1 History 

Version Date Amendments  

V1.0 27.11.2008 First edition (html) 

V1.1 27.11.2008 Supplemented and revised, converted to PDF file 
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